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Where to Find Information

Setup Guide

❏ This guide will help you set up and begin using your printer. 
It includes information on setting up your printer and 
installing the printer software.

Daily Use Guide

❏ This guide provides information on daily printer operation. 
It also contains troubleshooting tips and customer support 
information.

Online Guides included on the CD-ROM

The guides on the CD-ROM included with your printer will help 
you learn more about your printer and color printing. To view 
these guides, you must have a Web browser installed on your 
computer. For more information on using this CD-ROM, see the 
included CD-ROM Booklet.

❏ Reference Guide Provides detailed information about
printer software settings, printing on
special paper, maintenance, and problem
 solving.

❏ Color Guide Includes sample images, explanations and
troubleshooting information that will help
answer your questions about color imaging
and printing.
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Product Information

Safety Instructions

ENERGY STAR Compliance

As an ENERGY STAR Partner, EPSON has determined that this 
product meets the ENERGY STAR guidelines for energy 
efficiency.

The International ENERGY STAR Office Equipment Program is 
a voluntary partnership with the computer and office equipment 
industry to promote the introduction of energy-efficient personal 
computers, monitors, printers, fax machines, and copiers in an 
effort to reduce air pollution caused by power generation.

For United Kingdom Users

Use of options

EPSON (UK) Limited shall not be liable against any damages or 
problems arising from the use of any options or consumable 
products other than those designated as Original EPSON 
Products or EPSON Approved Products by EPSON (UK) Limited.
Safety Instructions      -1



  
Safety information

w Warning:
This appliance must be earthed. Refer to the rating plate for 
voltage and check that the appliance voltage corresponds to the 
supply voltage.

Important:
The wires in the mains lead fitted to this appliance are coloured in 
accordance with the following code:

If you have to fit a plug:
As the colours of the mains lead of this appliance may not match 
coloured markings used to identify the terminals in a plug, please 
proceed as follows:

The green and yellow wire must be connected to the terminal in 
the plug which is marked with the letter E or the earth symbol (G).

The blue wire must be connected to the terminal in the plug 
marked with the letter N.

The brown wire must be connected to the terminal in the plug 
marked with the letter L.

If damage occurs to the plug, replace the cord set or consult a 
qualified electrician.

Replace fuses only with a fuse of the correct size and rating.

Green and yellow Earth

Blue Neutral

Brown Live
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Warnings, Cautions, and Notes

w Warnings 
must be followed carefully to avoid bodily injury.

c Cautions 
must be observed to avoid damage to your equipment.

Notes 
contain important information and useful tips on the operation of your 
printer.
Safety Instructions      -3
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Printer Parts and Control Panel Functions

Printer Parts

1. Paper support: Supports the loaded paper.

2. Edge guides: Help load the paper straight. Adjust the left edge 
guide to fit the width of your paper.

3. Printer cover: Open only when installing or replacing ink 
cartridges.

4. Output tray: Receives ejected paper.

5. Output tray extension: Supports the ejected paper.
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6. Sheet feeder: Feeds a stack of paper automatically.

1. Ink cartridge clamps: Open only when installing or replacing 
ink cartridges.

2. Control panel

3. Adjust lever: Set to “+” position if ink smears on your 
document when you use thick paper.

Control panel

The control panel consists of buttons and indicator lights, and 
gives you access to several features. Match the icons on the control 
panel with those in the charts below.
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Buttons

Lights

Button Function

Power Turns the printer on and off. 

Clears the printer's memory if pressed twice while the 
power is on.

Load/Eject Loads or ejects paper if pressed and released within 
2 seconds. 

Resumes printing if pressed and released after a paper 
out error.

Cleaning Moves the print head to the ink cartridge replacement 
position if pressed for 3 seconds while the B black or 
A color ink out light is flashing or on.

Returns the print head to its home position after ink 
cartridge replacement.

Performs print head cleaning if pressed for 3 seconds 
when the B black or A color ink out light is off.

Light Printer Status

Power On when the printer is on.

Flashes when receiving data, printing, replacing an ink 
cartridge, charging ink, or cleaning the print head.

Paper out On when the printer is out of paper. Load paper in the 
sheet feeder, then press the E load/eject button to 
resume printing.

Flashes when the paper is jammed. Take all of the 
paper out of the feeder, then reload the paper. If the 
light continues to flash, turn off the printer and gently 
pull all the paper out of the printer.
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Black ink out Flashes when the black ink cartridge is nearly empty.

On when the black ink cartridge is empty. Replace the 
black ink cartridge (S020187).

Color ink out Flashes when the color ink cartridge is nearly empty.

On when the color ink cartridge is empty. Replace the 
color ink cartridge (S020191).
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How To

Paper Handling

Loading Plain Paper

Follow these steps to load plain paper in the printer.

1. Lower the output tray and slide out the extension. Next, slide 
the left edge guide so that the distance between the edge 
guides is slightly wider than the width of your paper.

2. Fan a stack of paper; then tap it on a flat surface to even the 
edges.

3. Load the stack of paper with the printable side up and the 
right edge of the paper resting against the right side of the 
sheet feeder. Then slide the left edge guide against the left 
edge of the paper.

Note:
❏ Always load paper into the sheet feeder short edge first.
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❏ Make sure the paper stack fits under the arrow mark inside the 
edge guide.

Loading Special Paper and Other Media

You can achieve good results with most plain bond paper. 
However, coated paper and glossy film result in higher quality 
printouts because these media absorb smaller amounts of ink.

EPSON provides special media that are formulated for the ink 
used in EPSON ink jet printers. EPSON recommends using media 
distributed by EPSON to ensure high-quality results. See “EPSON 
special media” for a complete list of these products.

When loading special paper distributed by EPSON, read the 
instruction sheets packed with your special media first and keep 
the following points in mind.

❏ Make sure the printable side of the paper is facing up when 
loading media into the sheet feeder. See the instruction sheets 
packed with the media to determine which side is the 
printable surface. Some media have cut corners to help 
identify the correct loading direction, as shown in the 
illustration.
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Note:
If you extend the printable area with the Maximum setting in the 
printer driver, the cut corner on special paper may mar your 
printout.

❏ Make sure the paper stack fits under the arrow mark located 
on the inside surface of the left edge guide.
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❏ Loading capacity for envelopes and EPSON special media is 
explained below.

Envelopes Up to 10 envelopes.

Note:
If the total thickness of the stack of 
envelopes exceeds 10 mm, press each 
envelope flat before loading.

360 dpi Ink Jet Paper and 
Photo Quality Ink Jet Paper

Up to the arrow mark on the left edge 
guide.

Photo Quality Ink Jet Card, 
Ink Jet Note Card, and Ink 
Jet Greeting Card

Up to 30 index cards. Always place the 
included support sheet* under the cards.

Photo Quality Glossy Film One sheet at a time for best results. Always 
put a support sheet* or a sheet of plain 
paper under the glossy film.
If you wish to load multiple sheets, load a 
maximum of 20 sheets and set the minimum 
top margin of the page to 30 mm.

Ink Jet Transparencies Up to 30 transparencies. Always put a sheet 
of plain paper under the stack of 
transparencies.

Photo Quality Self Adhesive 
Sheet

One sheet at a time.

Photo Paper Up to 20 sheets of 4 × 6 inch Photo Paper. 
Always put a support sheet* under the 
stack of Photo Paper.
200 × 300 mm Photo Paper can only be 
loaded 1 sheet at a time. 

Photo Stickers 16 and Photo 
Stickers 4

One sheet at a time. Always put the 
included Support Sheets A and B under the 
stack of Photo Stickers.

Panoramic Photo Paper 
and Iron-On Cool Peel 
Transfer Paper

One sheet at a time.

Matte Paper-Heavyweight Up to 20 sheets. Always put a support sheet* 
under the stack of Matte Paper-
Heavyweight.
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* Take care not to print on support sheets loaded under special media.

❏ If the paper is curled, make sure to flatten it or curl it slightly 
toward the opposite side before loading. Printing on curled 
paper may smear your printout, especially when printing 
with Maximum selected as the Printable Area setting.

❏ If ink smears on your documents when printing on thick 
media, set the adjust lever to the “+” position. To change the 
setting, open the printer cover and position the lever as shown 
in the illustration.

Note:
❏ Return the adjust lever to the “0” position before printing on 

media of normal thickness. Leaving the lever in the “+” position 
may cause gaps in the printed image. 

❏ When the adjust lever is in the “+” position, make sure the High 
Speed setting in the printer driver’s Advanced dialog box is off. 
To turn this option off, you may also need to change the Print 
Quality setting.
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If you wish to print on the reverse side of an Ink Jet Card with 
Maximum selected as the Printable Area setting, flatten the 
cards or curl them slightly toward the opposite side before 
loading. Set the adjust lever to the “+” position before 
printing.

About special media cleaning sheets

Cleaning sheets packaged with EPSON special media should not 
be used with this printer. The cleaning function performed by 
these sheets is not necessary with this type of printer, and the 
sheets could jam in the printer.

Loading Envelopes 

When printing on envelopes, please note the following:

❏ You can load up to 10 envelopes into the sheet feeder.

Note:
The folding quality and thickness of envelopes varies widely. If the 
total thickness of the stack of envelopes exceeds 10 mm, press each 
envelope in the stack flat before loading.

❏ Set the adjust lever to the “+” position. To do this, open the 
printer cover and reposition the lever.

Note:
❏ Return the adjust lever to the “0” position, which is the normal 

position, after you finish printing on envelopes. Leaving the 
lever in the “+” position may cause gaps to appear in images 
printed on other media.

❏ When the adjust lever is in the “+” position, make sure the High 
Speed setting in the printer driver’s Advanced dialog box is off. 
To turn this option off, you may also need to change the Print 
Quality setting.
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❏ Load envelopes flap edge first with the flap side down, as 
shown in the illustration.

❏ Do not use envelopes that are curled or folded. Make sure to 
flatten the envelope flaps before loading. Also avoid using 
envelopes that are too thin; they may curl during printing.

❏ Select Plain Paper as the Media Type setting on the printer 
driver.

Using EPSON Photo Paper (4 x 6 inch, 200 x 300 mm)

EPSON Photo Paper (S041134, S041254) is perforated around the 
margins so you can trim your printed images to look like 4 × 6 
inch (102 × 152 mm) or 200 × 300 mm photographs. Note the 
following when using Photo Paper.
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Loading

❏ Load the paper printable side up with the perforated margins 
positioned as shown in the illustration.

❏ Use flat, undamaged paper. If the paper or the support sheet 
is curled, flatten it before loading to avoid paper feeding 
problems.

❏ Always place the included support sheet under the stack of 
Photo Paper, but do not print on it.

❏ You can load up to 20 sheets of 4 × 6 inch Photo Paper or 1 
sheet of 200 × 300 mm Photo Paper into the sheet feeder.

❏ Cut or tear the paper at the perforation only after printing. Do 
not cut, tear, or fold the paper before printing.

❏ Select Photo Paper as the Media Type setting and Photo 
Paper 4X6 in or Photo Paper 200X300 mm as the Paper Size 
setting in your printer driver.
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Removing the perforated margins

❏ To remove the perforated margins, fold the paper back and 
forth a few times along the perforations, then carefully tear 
the margins off.

❏ You can also remove the margins by cutting along the 
perforations.

Note:
Keep in mind that the edges of your image might be cut off when you 
remove the perforated margins. See the illustration below.
Paper Handling      -17



4 ×××× 6 inch

A: trimmed size

B: printed image size
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200 ×××× 300 inch

Storing EPSON Photo Paper

❏ Return unused paper to the original package as soon as you 
finish printing, and avoid storing it in places exposed to high 
temperature, humidity, or direct sunlight.

❏ EPSON recommends storing your printouts in a resealable 
plastic bag and keeping them away from high temperature, 
humidity, and direct sunlight.

A: trimmed size

B: printed image size
Paper Handling      -19



Printing with Windows

Printer Software Introduction

The printer software includes a printer driver and printer utilities. 
The printer driver lets you choose from a wide variety of settings 
to get the best results from your printer. The printer utilities help 
you check the printer and keep it in top condition.

Getting more information

For information on using the printer driver, see “Making Changes 
to Printer Driver Settings”.

For information on using the printer utilities, see “Using the 
Printer Utilities”.

Note:
The specific features available in the printer software vary depending on 
the version of Windows you are using.

Online help provides more information about the printer 
software. See “Getting Information Through Online Help” for 
instructions on accessing help.

Accessing the printer software

You can access the printer software from most Windows 
applications, or from the Windows Start menu.

When you access the printer software from a Windows 
application, the settings you make apply only to the application 
you are using.

When you access the printer software from the Start menu, the 
settings you make apply to all of your Windows applications.
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From Windows applications

Open the File menu and choose Print or Print Setup. Then click 
Printer, Setup, Options, or Properties. (Depending on your 
application, you may need to click a combination of these 
buttons.) The printer software window appears.

From the Start menu

1. Click Start, point to Settings, then click Printers.

2. For Windows 95 and 98, select your printer, then click 
Properties on the File menu. For Windows NT 4.0, select your 
printer, then click Document Defaults on the File menu. The 
printer software window appears.

Making Changes to Printer Driver Settings

The printer software features the following printer driver setting 
menus.

The Mode options on the Main menu are arranged to give you 
four levels of control over the printer driver, as explained below.

Main Media Type, Ink, Mode

Paper Paper size, Copies, Orientation, Printable Area

Layout Reduce/Enlarge, Multi-Page, Watermark

Automatic The quickest and easiest way to start 
printing. See “Using the Automatic 
mode”.

PhotoEnhance Lets you apply a variety of image-
correction settings specially designed for 
photos. See “Using the Photo Enhance 
mode”.
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In addition to making groups of settings that affect overall print 
quality, you can also modify individual aspects of the print style 
and layout using the Paper and Layout menus. See “Modifying 
the printout style”.

Making the Media Type setting

The Media Type setting determines what other settings are 
available, so you should always make this setting first.

On the Main menu, select the Media Type setting that matches 
the paper you loaded in the printer. Find your paper in the list 
below, then select a corresponding Media Type setting (shown in 
bold). For some kinds of paper, you have several Media Type 
settings to choose from.

Custom Choose from a list of ready-made settings 
suited to the kind of document you want 
to print. You can also add your own 
settings to this list. See “Using the Custom 
mode”.

Advanced Allows you to make detailed settings to fit 
your individual needs. You can also add 
your settings to the Custom Settings list. 
See “Using the Advanced settings”.
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Plain Paper

360 dpi Ink Jet Paper

Photo Quality Ink Jet Paper

Plain paper

Envelopes

EPSON Premium Ink Jet Plain Paper (A4) S041214

EPSON 360 dpi Ink Jet Paper (A4) S041059
S041025

EPSON 360 dpi Ink Jet Paper (Letter) S041060
S041028

EPSON Iron-On Cool Peel Transfer Paper (A4) S041154

EPSON Iron-On Cool Peel Transfer Paper (Letter) S041153
S041155

EPSON Photo Quality Ink Jet Paper (A4) S041061
S041026

EPSON Photo Quality Ink Jet Paper (Letter) S041062
S041029

EPSON Photo Quality Ink Jet Paper (Legal) S041067
S041048

EPSON Photo Quality Ink Jet Card (A6) S041054

EPSON Photo Quality Ink Jet Card (5 × 8”) S041121

EPSON Photo Quality Ink Jet Card (8 × 10”) S041122

EPSON Photo Quality Self Adhesive Sheet (A4) S041106

EPSON Ink Jet Note Cards A6 (with envelopes) S041147

EPSON Ink Jet Greeting Cards 5 x 8” (with envelopes) S041148

EPSON Ink Jet Greeting Cards 8 x 10” (with envelopes) S041149
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Photo Paper

Photo Quality Glossy Film

Ink Jet Transparencies

Matte Paper-Heavyweight

Note:
The availability of special media varies by location.

EPSON Photo Paper (A4) S041140

EPSON Photo Paper (Letter) S041141

EPSON Photo Paper (4 × 6”) S041134

EPSON Photo Paper (100 × 150 mm) S041255

EPSON Photo Paper (200 × 300 mm) S041254

EPSON Panoramic Photo Paper (210 × 594 mm) S041145

EPSON Photo Paper Cards (A4) S041177

EPSON Photo Quality Glossy Film (A4) S041071

EPSON Photo Quality Glossy Film (Letter) S041072

EPSON Photo Quality Glossy Film (A6) S041107

EPSON Photo Stickers 16 (A6) S041144

EPSON Photo Stickers 4 (A6) S041176

EPSON Ink Jet Transparencies (A4) S041063

EPSON Ink Jet Transparencies (Letter) S041064

EPSON Matte Paper-Heavyweight (A4) S041256
S041258
S041259
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Using the Automatic mode

When Automatic is selected on the Main menu, the printer driver 
takes care of all detailed settings based on the current Media Type 
and Ink settings. To make the Ink setting, click Color to print in 
color, or Black to print in black-and-white or grayscale. To make 
the Media Type setting, see “Making the Media Type setting”.

Note:
❏ Depending on the media you choose in the Media Type list (while 

Automatic is selected), a slide bar appears in the Mode box that 
lets you choose Quality or Speed. Select Quality when print 
quality is more important than speed.

❏ Most Windows applications feature paper size and page layout 
settings that override similar settings on the printer driver. 
However, if your application does not have these settings, verify the 
settings on the printer driver’s Paper menu.
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Using the Photo Enhance mode

The Photo Enhance option provides a variety of image-correction 
settings that you can apply to your photo images before printing. 
Photo Enhance does not affect your original data.

If you are printing photos taken with a digital camera, you can 
also select the Digital Camera Correction check box to give your 
printed images the smooth, natural appearance of photographs 
taken with a film camera.

Note:
❏ This mode is available only when you are printing in color.

❏ Printing with Photo Enhance selected may increase print time 
depending on your computer system and the amount of data 
contained in your image.

The Photo Enhance mode provides the following settings.

Using the Custom mode

The Custom mode offers ready-made settings designed for 
printing text and graphs and for applying a color-matching 
method. You can also create and save your own Custom settings. 
See “Using the Advanced settings” for details.

Standard Standard image correction for most photos. Try this 
setting first.

People Best for photos of people.

Nature Best for outdoor scenery such as mountains, skies, and 
oceans.

Soft Focus Makes your photos look as if they were taken with a 
soft-focus lens.

Sepia Applies a sepia tone to your photos.
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The Custom mode provides the following ready-made settings.

Follow the steps below to select a Custom setting.

1. Click the Custom button on the Main menu.

2. Click anywhere in the list box to open it, then select the most 
appropriate setting for the type of document or image you 
will print.

3. When you choose a Custom setting, other settings such as 
Print Quality, Halftoning, and Color Adjustment are set 
automatically. Changes are shown in the display on the left 
side of the Main menu.

4. Before printing, be sure to verify the Media Type and Ink 
settings, as they may be affected by the Custom setting you 
select. See “Making the Media Type setting”.

Using the Advanced settings

The Advanced settings give you complete control over your 
printing environment. Use these settings to experiment with new 
printing ideas, or to fine-tune a range of print settings to meet 
your individual needs. Once you are satisfied with your new 
settings, you can give them a name and add them to the Custom 
settings list.

Text/Graph Good for printing presentation 
documents such as graphs and charts.

Economy Good for printing drafts of text

ICM

(For Windows 95 and 
98)

ICM means Image Color Matching. This 
feature automatically adjusts printout 
colors to match colors on your screen.

sRGB Best for color matching with other sRGB 
devices.
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Follow the instructions below to make and save Advanced 
settings.

Note:
The printer driver screens that appear in this procedure are for 
Windows 95 and 98. The Windows NT 4.0 printer driver screens differ 
only slightly.

1. Click the Custom button on the Main menu and then click 
Advanced. The following dialog box appears.

2. Select the Media Type you loaded in the printer. For details, 
see “Making the Media Type setting”.

3. Choose Color or Black as the Ink setting.

4. Select the Print Quality setting.

5. Make other settings as necessary. For details, see online help.
-28      



Note:
❏ The Photo Enhance 4 setting under the Color Management 

option only affects images, not text or graphs. For example, if 
Monochrome is selected from the Tone list, only the images in 
a document will be printed in monochrome. Any colored text or 
graphs in the same document will be printed in color.

❏ Some settings may be disabled depending on the Media Type, 
Ink, and Print Quality settings you make.

6. Click OK to apply your settings and return to the Main menu. 
If you want to return to the Main menu without applying your 
settings, click Cancel.

To save your Advanced settings, click Save Settings in the 
Advanced dialog box. The Custom Settings dialog box appears.

Type a unique name for your settings in the Name box, and click 
Save. Your settings will be added to the Custom Settings list.

Note:
❏ You cannot use the names of settings provided by EPSON for your 

custom settings.

❏ To delete a setting, select the setting in the Custom Settings dialog 
box and click Delete.
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❏ You cannot delete the ready-made settings from the Custom Settings 
list.

When you select your saved settings in the Custom Settings list, 
be aware that making new settings (for example Media Type and 
Ink settings) may change your custom settings. This may cause 
unexpected results in your printout. If this happens, reselect your 
saved settings and try printing again.

Previewing your printout

To see a preview of your document before printing it, select the 
Print Preview check box on the Main menu. When you select the 
Print option in your application, the Print Preview window 
appears:

You can manipulate the previewed document in the following 
ways:

❏ Select and preview individual pages.
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❏ Reduce or enlarge the size of the preview.

❏ Select and print any or all pages. 

❏ Apply watermarks. The watermark you select will appear in 
the previewed image. For detailed information on 
customizing watermarks, see “Printing a watermark on your 
document”. 

After you have previewed the document, click Print to print the 
document, or click Cancel to cancel printing.

Modifying the printout style

You can modify your printout style using a variety of printer 
driver settings located on the Paper and Layout menus.

On the Paper menu, you can make settings for the paper size, the 
number of copies, the orientation of your printout, and the 
printable area. On the Layout menu, you can automatically match 
the document size to the paper size, print 2 or 4 pages on a single 
sheet, print poster-size images by enlarging one page to cover 
several sheets, or place watermarks on documents.
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Using the Paper menu settings

Use the Paper menu to change the paper size, set the number of 
copies and other copy parameters, specify the paper orientation, 
and adjust the printable area.

You can make the following settings:

Paper Size Select the paper size you want to use. You can also 
add a custom paper size.

Copies Select the number of copies you wish to print. You 
can select Collate (print a set at a time) or Reverse 
Order to determine the order in which you print 
multiple copies of your document:

Orientation Select Portrait (tall) or Landscape (wide) to change 
the orientation of your printout. If you need to print 
closer to the bottom of the page, select the Rotate 
by 180° check box.
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Fitting your document to the paper size

To fit the size of your document to the size of the paper you will 
print on, use the Reduce/Enlarge options on the Layout menu.

You can select the following.

Printable Area Use the options in the Printable Area box to adjust 
the total area available for printing. If you want to 
center the printout, click Center. If you need to 
increase the printable area, click Maximum.

Note:
When Maximum is selected, the print quality may 
decline at the edges of the printout. Before printing 
large jobs using this setting, print a single sheet to 
confirm quality.
When Maximum is selected, make sure the paper 
loaded in the sheet feeder is not curled.

Normal Prints your document at its normal size.

Fit to Page Proportionally enlarges or reduces the size of 
your document to make it fit the paper size you 
select in the Paper Size list on the Paper menu.
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Printing 2 or 4 pages on one sheet

To print 2 or 4 pages of your document on one sheet of paper, use 
the Multi-Page option on the Layout menu.

Select N-up as the Multi-Page option, then make the following 
settings.

Custom Allows you to manually reduce or enlarge an 
image. Click the arrows next to the Proportion 
box to select a percentage from 10% to 400%.

2 Pages
4 Pages

Prints 2 or 4 pages of your document on a 
single piece of paper.

Page Order Allows you to specify the order in which the 
pages will be printed on the sheet of paper.

Print page 
frames

Allows you to print a frame around each page 
on the sheet of paper.
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Printing posters

You can use the Poster setting in the Multi-Page option to print a 
poster-size image. A single document page can be enlarged to 
cover 4, 9, or 16 printed sheets of paper.

To adjust the way your poster will print, click the Settings button. 
The Poster Settings dialog box appears.
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You can make the following settings.

If you only want to print a few of the panels without printing the 
entire poster, click the panels you don’t wish to print, then click 
OK to close the Poster Settings dialog box.

Printing a watermark on your document

To print a watermark on your document, on the Layout menu, 
click anywhere in the Watermark list box to open it, and select 
from the list of predefined watermarks.

You can also add your own text-based or image-based 
watermarks to the Watermark list. Follow these steps.

1. Click the Add/Del button. The following dialog box appears.

Overlapping 
Panels

Slightly overlaps the images so that they can be 
aligned more precisely.

Print Cutting 
Guidelines

Prints border lines on the images to guide you 
when trimming the pages.
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2. To use an image file as a watermark, select BMP. Click the 
Browse button to select the bitmap file you want to use, then 
click OK. To create a text-based watermark, select Text, then 
type your text in the Text box.

3. Type a name for your watermark in the Watermark box, then 
click Save. Click OK to return to the Layout menu.

4. To make settings for your watermark, click the Settings 
button. The following dialog box appears.

5. From the Watermark list box, select the watermark you want 
to make settings for, then make color, position, density, and 
size settings. Your settings appear on the left side of the 
dialog. After you make settings, click OK.
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Using the Printer Utilities

EPSON printer utilities allow you to check the current printer 
status and to perform some printer maintenance from your 
computer screen.

To use the utilities, click the Utility tab in the printer software 
window, then click the button for the utility you wish to use. For 
information on how to access the printer software, see “Accessing 
the printer software”.

Note:
❏ The letter in parentheses after the utility name indicates the shortcut 

key for that utility. Press Alt and the letter on the keyboard to open 
that utility.
-38      



❏ Do not use the Nozzle Check, Head Cleaning, and Print Head 
Alignment utilities with printers connected to your computer 
through a network.

❏ Do not use the Nozzle Check, Head Cleaning, and Print Head 
Alignment utilities while printing is in progress; otherwise, your 
printout may be marred.

Status Monitor 3

Provides you with printer status information, such as the amount 
of ink remaining, and checks for printer errors.

This utility is available only when:

❏ The printer is connected directly to the host computer via the 
parallel port [LPT1], and

❏ Your system is configured to support bidirectional 
communication.

Nozzle Check

Checks the print head nozzles for clogging. Check the nozzles if 
you notice print quality has declined and after cleaning to confirm 
that the print head nozzles have been cleared. If the nozzle check 
indicates the print head needs cleaning, you can access the Head 
Cleaning utility directly from the Nozzle Check utility. See 
“Checking the Print Head Nozzles”.

Head Cleaning

Cleans the print head. You may need to clean the head when you 
notice print quality has declined. Use the Nozzle Check utility 
first to confirm that the head needs to be cleaned. You can access 
the Nozzle Check utility directly from the Head Cleaning utility. 
See “Cleaning the Print Head”.
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Print Head Alignment

Aligns the print head. Use this utility if you notice a misalignment 
of vertical lines. 

Speed & Progress

You can make settings related to print speed and progress with 
this feature.

High Speed Copies

To print multiple copies of your document faster, select High 
Speed Copies.

Show Progress Meter

To monitor the progress of your print, select Show Progress 
Meter.
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EPSON Printer Port (For Windows 95 and 98 only)

To speed up the data transfer rate to EPSON printers, select 
EPSON Printer Port.

If your computer supports ECP mode, enable DMA transfer to 
speed up printing.

For more details, see “Using Speed & Progress”.

Always Spool Raw Datatype (For Windows NT only)

Select this check box to have Windows NT-based clients spool 
documents using the RAW format instead of the EMF (metafile) 
format (Windows NT-based applications use the EMF format by 
default).

Try using this option if documents spooled in EMF format do not 
print correctly.

Spooling RAW datatype requires less resources than EMF, so 
some of problems (“Insufficient Memory/Disk Space to Print”, 
“Slot print speed”, etc.) can be solved by selecting the “Always 
spool RAW datatype” check box.

When spooling RAW datatype, print progress as displayed by the 
Progress Meter may differ from actual print progress.

Monitoring Preferences

Click this button to open the Monitoring Preferences dialog box 
where you can make settings for EPSON Status Monitor 3. The 
settings are described in detail in the next section.
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Monitoring Preferences 

When you click the Monitoring Preferences button, the 
following dialog box appears. 

You can make the following settings: 

Note:
Click the Default button to revert all items to the default settings.

Select 
Notification

Displays the current error item notification settings.

Select the appropriate check boxes to specify the error 
types for which you wish to receive notification.

Select 
Shortcut 
Icon 

Select the Shortcut Icon check box to have a shortcut 
icon placed in your Windows taskbar. Clicking the 
shortcut icon in the taskbar will open EPSON Status 
Monitor 3. To select which icon will be displayed, click 
the icon your prefer from the choices given; your 
selection will be shown at the right. 

Allow 
monitoring 
of shared 
printer

When this check box is selected, a shared printer can 
be monitored by other PCs.
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Getting Information Through Online Help 

Your printer software has an extensive online help feature, which 
provides you with instructions on printing, making printer driver 
settings, and using printer utilities.

Accessing help from your application

Open the File menu and choose Print or Print Setup. Then click 
Printer, Setup, Options, or Properties. (Depending on your 
application, you may need to click a combination of these 
buttons.) Click Help at the bottom of the Main, Paper, Layout, and 
Utility menus for help related to the items on that menu.

You can get specific help related to any item on a menu by right-
clicking the item, then clicking the What's This? prompt.

Accessing help from the Start menu

Click the Start button, point to Programs and Epson (for 
Windows 95 and 98) or EPSON Printers (for Windows NT 4.0), 
then click EPSON Stylus COLOR 660 Help. The help contents 
window appears.

Increasing the Print Speed

General tips

Just as printing at a high resolution requires more processing 
time, printing in color takes longer than printing in black because 
the volume of data in a color document is much greater. For this 
reason, it is important to be selective in your use of color if you 
also require a faster print speed.
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However, even if your document requires the highest resolution 
and extensive use of color, for example when you are printing a 
camera-ready composite that includes color photographs, it may 
still be possible to optimize the print speed by adjusting other 
printing conditions. Keep in mind that changing some conditions 
to increase the print speed may also lower print quality.

The following table shows the factors that inversely affect print 
speed and print quality (increasing one will decrease the other).

Print quality
Print speed

Lower
Faster

Higher
Slower

Printer driver settings

Print Quality Economy,
Normal

Super Fine

High Speed On Off

Halftoning No Halftoning Error Diffusion

Finest Detail Off On

Data characteristics

Image size Small Large

Resolution Low High
-44      



The table below shows the factors related to print speed only.

 * Varies depending on the printer driver and application software you are 
using.

** Grayscale means using black ink only to print varying shades of gray, from 
pure black to pure white.

Print speed

Faster Slower

Printer driver settings

Ink Black Color

Collate* Off On

Flip Horizontal* Off On

Reverse Order* Off On

Data characteristics

Variety of colors Grayscale** Full color

Hardware resources

System speed Fast Slow

HDD free space Large Small

Memory free 
space

Large Small

Software status

Running 
applications

One Many

Virtual memory Not in use In use
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Using Speed & Progress

You can make certain print speed settings in the Speed & Progress 
dialog box. Click the Speed & Progress button on your printer 
software’s Utility menu. The following dialog box appears.

High Speed Copies

Select to turn on high-speed printing for multiple copies. This 
speeds up printing by using your hard disk space as a cache when 
printing multiple copies of your document.

Show Progress Meter

Select to display the printing progress on the computer screen 
while printing.

EPSON Printer Port (For Windows 95 and 98 only)

Select to enable the EPSON printer port, which is optimized for 
EPSON printers, instead of the Windows default printer port. 
This speeds up the data transfer rate to EPSON printers.
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Always Spool Raw Datatype (For Windows NT only)

Select this check box to have Windows NT-based clients spool 
documents using the RAW format instead of the EMF (metafile) 
format (Windows NT-based applications use the EMF format by 
default).

Try using this option if documents spooled in EMF format do not 
print correctly.

Spooling RAW datatype requires less resources than EMF, so 
some of problems (“Insufficient Memory/Disk Space to Print”, 
“Slot print speed”, etc.) can be solved by selecting the “Always 
spool RAW datatype” check box.

When spooling RAW datatype, print progress as displayed by the 
Progress Meter may differ from actual print progress.

Monitoring Preferences

Click this button to open the Monitoring Preferences dialog box 
where you can make settings for EPSON Status Monitor 3. For a 
detailed description of the available settings, see “Monitoring 
Preferences”.

To enable DMA transfer (For Windows 95 and 98 only)

If your computer has a parallel port which supports ECP mode, 
you can enable DMA transfer to speed up printing. See your 
computer manual to determine if it supports ECP mode and DMA 
transfer.

To determine whether you need to enable DMA transfer, compare 
the message below the EPSON Printer Port check box to this table, 
and take the recommended action.

Message Action

High Speed (DMA) 
Transfer enabled.

DMA transfer is already enabled. Click OK 
to close the dialog box.
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If you need to enable DMA transfer, follow these steps.

1. Double-click the My Computer icon on your desktop, then 
double-click Control Panel.

2. Double-click the System icon and click the Device Manager 
tab.

3. Double-click the Ports (COM & LPT) icon and double-click 
LPT1. If you have connected your printer to a port other than 
LPT1, double-click the appropriate port icon.

For higher data transfer 
rates, use DMA Transfer.

Follow the steps below this table to enable 
DMA transfer.

(No message) Your system's parallel port setting does not 
allow DMA transfer. However, if you 
change the parallel port setting to ECP or 
Enhanced using your computer's BIOS 
Setup program, you may be able to use 
DMA transfer. Consult your computer 
manual or computer manufacturer for 
instructions. Once you change the 
parallel port setting, follow the steps 
below this table to enable DMA transfer.

Note:
Before you run the BIOS Setup program, 
uninstall the printer driver using Add/
Remove Programs in the Control Panel. 
After running the BIOS Setup program, 
reinstall the printer driver.

Message Action
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4. Click the Resources tab, then deselect the Use automatic 
settings check box. Write down the Input/Output Range 
settings shown in the Resource settings box.

5. Select a basic configuration setting from the Setting based 
on list that uses the same Input/Output Range settings as 
those you wrote down in Step 4, and make sure the Direct 
Memory Access channel and Interrupt Request numbers are 
allocated and displayed. Confirm also that the Conflicting 
Device list box shows No conflicts.

6. Click OK to save the settings.

7. Reopen the Speed & Progress dialog box to verify whether 
DMA transfer has been enabled.

Note:
You may not be able to use DMA transfer on some computers even after 
you make the settings explained above. Consult your computer maker 
for information on the DMA transfer capability of your computer.
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Using Port Configuration (Windows NT 4.0 only)

Note:
Port settings for Windows NT 4.0 are complicated and should only be 
made by an experienced person with administrative privileges.

If your computer has a parallel port that supports ECP mode, you 
can make certain print speed settings in the Port Configuration 
dialog box. Before making settings, make sure that ECP mode has 
been selected in your computer settings. For details about ECP 
mode, see your computer manual.

To access the Port Configuration dialog box, click the Start button, 
point to Settings, and click Printers. Then select your printer and 
click Properties on the File menu. The printer driver window 
appears. Click the Ports tab, then click Configure Port. The 
following dialog box appears.

Click the LPT port tab for the port to which your printer is 
connected, then click the Port Configuration button.
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Note:
If your printer is connected to LPT1, only the LPT1 tab is available.

Resources Settings (IRQ and DMA)

If you have connected your printer to LPT2 or LPT3, making IRQ 
and DMA settings here may speed up printing. Input the same 
configuration numbers for IRQ and DMA which you have made 
with your expansion board. See your computer documentation to 
determine the settings for IRQ and DMA.

Use DMA transfer

Using DMA transfer to send print data to the computer may help 
you speed up printing. If the Use DMA Transfer check box is 
dimmed, you must first enable DMA transfer in your computer 
settings. For details, see your computer documentation.
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Printing with Macintosh

Printer Software Introduction

The printer software includes a printer driver and printer utilities. 
The printer driver lets you choose from a wide variety of settings 
to get the best results from your printer. The printer utilities help 
you check the printer and keep it in top condition.

For information on using the printer driver, see “Making Changes 
to Printer Driver Settings”.

For information on using the printer utilities, see “Using the 
Printer Utilities for Macintosh”.

You can get more information about the printer software by 
clicking the help icon in the printer software dialog boxes.

Making Changes to Printer Driver Settings

You will find the printer driver settings in the following dialog 
boxes.

❏ Print dialog box (click Print on the File menu of your 
application or click Options in the Page Setup dialog box)

❏ Page Setup dialog box (click Page Setup on the File menu of 
your application)

❏ Layout dialog box (click the Layout icon button in the Print 
dialog box)

❏ Background Printing dialog box (click the Background 
Printing icon button located in the Print dialog box)
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❏ Preview dialog box (click the Preview icon button and then 
click Preview in the Print dialog box)

The Mode options in the Print dialog box are arranged to give you 
four levels of control over the printer driver, as explained below.

In addition to making groups of settings that affect overall print 
quality, you can also change page setup and layout using the Page 
Setup and the Layout dialog boxes. For information on page setup 
options, see “Changing the page setup”. For information on page 
layout options, see “Modifying the layout”.

Making the Media Type setting

The Media Type setting determines what other settings are 
available, so you should always make this setting first.

In the Print dialog box, select the Media Type setting that matches 
the paper you loaded in the printer. Find your paper in the list 
below, then select a corresponding Media Type setting (shown in 
bold). For some kinds of paper, you have several Media Type 
settings to choose from.

Automatic The quickest and easiest way to start 
printing. See “Using the Automatic 
settings”.

Custom Choose from a list of ready-made settings 
suited to the kind of document you want 
to print. You can also add your own 
settings to this list. See “Using the Custom 
mode”.

Advanced Allows you to make detailed settings to fit 
your individual needs. You can also add 
your settings to the Custom Settings list. 
See “Using the Advanced settings”.

PhotoEnhance Lets you apply a variety of image-
correction settings specially designed for 
photos. See “Using the Photo Enhance 
mode”.
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Plain Paper

360 dpi Ink Jet Paper

Photo Quality Ink Jet Paper

Plain paper

Envelopes

EPSON Premium Ink Jet Plain Paper (A4) S041214

EPSON 360 dpi Ink Jet Paper (A4) S041059
S041025

EPSON 360 dpi Ink Jet Paper (Letter) S041060
S041028

EPSON Iron-On Cool Peel Transfer Paper (A4) S041154

EPSON Iron-On Cool Peel Transfer Paper (Letter) S041153
S041155

EPSON Photo Quality Ink Jet Paper (A4) S041061
S041026

EPSON Photo Quality Ink Jet Paper (Letter) S041062
S041029

EPSON Photo Quality Ink Jet Paper (Legal) S041067
S041048

EPSON Photo Quality Ink Jet Card (A6) S041054

EPSON Photo Quality Ink Jet Card (5 × 8”) S041121

EPSON Photo Quality Ink Jet Card (8 × 10”) S041122

EPSON Photo Quality Self Adhesive Sheet (A4) S041106

EPSON Ink Jet Note Cards A6 (with envelopes) S041147

EPSON Ink Jet Greeting Cards 5 x 8” (with envelopes) S041148

EPSON Ink Jet Greeting Cards 8 x 10” (with envelopes) S041149
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Photo Paper

Photo Quality Glossy Film

Ink Jet Transparencies

Matte Paper-Heavyweight

Note:
The availability of special media varies by location.

EPSON Photo Paper (A4) S041140

EPSON Photo Paper (Letter) S041141

EPSON Photo Paper (4 × 6”) S041134

EPSON Photo Paper (100 × 150 mm) S041255

EPSON Photo Paper (200 × 300 mm) S041254

EPSON Panoramic Photo Paper (210 × 594 mm) S041145

EPSON Photo Paper Cards (A4) S041177

EPSON Photo Quality Glossy Film (A4) S041071

EPSON Photo Quality Glossy Film (Letter) S041072

EPSON Photo Quality Glossy Film (A6) S041107

EPSON Photo Stickers 16 (A6) S041144

EPSON Photo Stickers 4 (A6) S041176

EPSON Ink Jet Transparencies (A4) S041063

EPSON Ink Jet Transparencies (Letter) S041064

EPSON Matte Paper-Heavyweight (A4) S041256
S041258
S041259
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Using the Automatic settings

When Automatic is selected as the Mode option in the Print dialog 
box, the printer driver takes care of all detailed settings based on 
the current Media Type and Ink settings. To make the Ink setting, 
click Color to print in color, or Black to print in black-and-white 
or grayscale. To make the Media Type setting, see “Making the 
Media Type setting” on page 53.

Note:
Depending on the media you choose in the Media Type list while 
Automatic is selected, a slide bar appears in the Mode box that lets you 
choose Quality or Speed. Select Quality when print quality is more 
important than speed.

Using the Photo Enhance mode

The Photo Enhance option provides a variety of image-correction 
settings that you can apply to your photo images before printing. 
Photo Enhance does not affect your original data.

If you are printing photos taken with a digital camera, you can 
also select the Digital Camera Correction check box to give your 
printed images the smooth, natural appearance of photographs 
taken with a film camera.

Note:
❏ This mode is available only when you are printing in color.
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❏ Printing with Photo Enhance selected may increase print time 
depending on your computer system and the amount of data 
contained in your image.

The Photo Enhance mode provides the following settings.

Using the Custom mode

The Custom mode offers ready-made settings designed for 
printing text and graphs and for applying a color-matching 
method. You can also create and save your own Custom settings. 
See “Using the Advanced settings”.

The Custom mode provides the following ready-made settings.

Follow these steps to select a Custom setting.

1. Verify the Media Type and Ink settings in the Print dialog box. 
For details, see “Making the Media Type setting”.

Standard Standard image correction for most photos. Try this 
setting first.

People Best for photos of people.

Nature Best for outdoor scenery such as mountains, skies, and 
oceans.

Soft Focus Makes your photos look as if they were taken with a 
soft-focus lens.

Sepia Applies a sepia tone to your photos.

Text/Graph Good for printing presentation 
documents such as graphs and charts.

Economy Good for printing drafts of text.

ColorSync This feature automatically adjusts printout 
colors to match colors on your screen.
      -57



2. Click the Custom button in the Print dialog box. This 
activates the Custom Settings list, located below and to the 
right of the Custom radio button.

3. From the Custom Settings list, select the most appropriate 
setting for the type of document or image you will print.

4. When you choose a Custom setting, other settings such as 
Print Quality, Halftoning, and Color are set automatically. 
Changes are shown in the display on the left side of the Print 
dialog box. 

Using the Advanced settings 

The Advanced settings give you complete control over your 
printing environment. Use these settings to experiment with new 
printing ideas, or to fine-tune a range of print settings to meet 
your individual needs. Once you are satisfied with your new 
settings, you can give them a name and add them to the Custom 
Settings list.

1. Click the Custom button in the Print dialog box, then click 
the Advanced button. The Advanced dialog box appears.

2. Select the Media Type that you loaded in the printer. For 
details, see “Making the Media Type setting”.
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3. Choose Color or Black in the Ink setting.

4. Select the Print Quality setting.

5. Make other settings as necessary. For details, see online help.

Note:
❏ The Photo Enhance 4 setting under the Color Management 

option only affects images, not text or graphs. For example, if 
Monochrome is selected from the Tone list, only the images in 
a document will be printed in monochrome. Any colored text or 
graphs in the same document will be printed in color.

❏ Some settings may be disabled depending on the Print Quality, 
Media Type, and Ink settings you make.

6. Click OK to apply your settings and return to the Print dialog 
box. Click Cancel to return to the Print dialog box without 
applying your settings. To save your Advanced settings, see 
the next section.

Saving and deleting your settings

To save your Advanced settings, click Save Settings in the 
Advanced dialog box. The Custom Settings dialog box appears.

Type a unique name (up to 16 characters) for your settings in the 
Name box, and click Save.
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Note:
The names of the ready-made settings provided by EPSON cannot be 
applied to your new settings.

You can save up to 10 different custom settings. You can select 
the setting from the Custom Settings list in the Print dialog box.

To delete a setting, select the setting in the Custom Settings dialog 
box and click Delete.

Note:
You cannot delete the ready-made settings from the Custom Settings list.

Using your saved settings

To select your settings, click the Custom button in the Print dialog 
box, then select your setting in the Custom Settings list, located 
below and to the right of the Custom button.

If you change the Media Type or Ink settings when one of your 
customized settings is selected in the Custom Settings list, the 
selection shown in the list returns to Custom Settings. The 
customized setting that was previously selected is not affected by 
the change. To return to your customized setting, simply reselect 
it in the list.

Changing the page setup

In the Page Setup dialog box, you can change the paper size, 
specify the orientation of your printout, and adjust the printable 
area.
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Choose Page Setup on the File menu of your application. The 
Page Setup dialog box appears.

You can change the following settings.

Defining a custom paper size

If your paper size is not included in the paper size list in the Page 
Setup dialog box, follow the steps below to define a custom paper 
size.

Paper Size Select the paper size you want to use. If you want 
to define a custom paper size, see “Defining a 
custom paper size” on page 61.

Orientation Select Portrait (tall) or Landscape (wide) to change 
the orientation of your printout. If you need to print 
close to the bottom of the page, select Rotate by 
180 degrees.

Reduce or 
Enlarge

Use this setting to reduce or enlarge the size of your 
image.

Printable Area Select Maximum to increase the printable area.

Note:Note:Note:Note:
When Maximum is selected, print quality may 
decline at the edges of the printout. Before printing 
large jobs using this setting, print a single sheet to 
confirm quality. Also, make sure the paper loaded 
in the sheet feeder is not curled.

Click Centered to position your printout at equal 
distances from the edges of the paper.
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1. In the Page Setup dialog box, click Customize. The following 
dialog box appears.

2. To define a new paper size, click New. The dialog box updates 
to allow you to enter a name for the new size.

3. Type the paper size name in the New Paper Size box.

4. Specify the measurement unit as either Inches or cm.

5. Enter the width and the height of your paper.

6. Click OK. You return to the Page Setup dialog box.

You can define up to 30 paper sizes. The paper size names you 
create will appear in the Paper Size menu in the Page Setup dialog 
box.
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To delete a custom paper size, click Customize in the Page Setup 
dialog box, select it from the list in the Custom Paper dialog box, 
and click Delete.

Modifying the layout

You can modify the page layout of your document using the 
printer driver settings located in the Layout dialog box, shown 
below. To open this dialog box, click Print on the File menu of your 
application and click the  Layout icon button in the Print dialog 
box. The Layout dialog box appears.

The Layout dialog box allows you to automatically match the 
document size to the paper size, print 2 or 4 pages on a single 
sheet, print poster-size images by enlarging one page to cover 
several sheets, or place watermarks on documents.

Fitting your document to the paper size

You can proportionally enlarge or reduce the size of the image to 
make it fit the paper size you select in the Paper Size list. To do 
this, select the Fit to Page check box, then specify the paper size 
you loaded in the printer in the Paper Size list.
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Printing 2 or 4 pages on one sheet

To print 2 or 4 pages of your document on one sheet of paper, use 
the Multi-Page option in the Page Layout dialog box.

Select the Multi-Page check box and click N-up. Then make the 
following settings. 

2 Pages
4 Pages

Prints 2 or 4 pages of your document on a 
single piece of paper.

Page Order Allows you to specify the order in which the 
pages will be printed on the sheet of paper.

Print page 
frames

Allows you to print a frame around each page 
on the sheet of paper.
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Printing posters

You can use the Poster setting in the Multi-Page option to print a 
poster-size image. A single document page can be enlarged to 
cover 4, 9, or 16 printed sheets of paper.

Select the Multi-Page check box and click Poster. Then make the 
following settings.

If you only want to print a few of the panels without printing the 
entire poster, click Panel Selection, click the panels you don’t 
wish to print, then click OK. Only the panels that you did not click 
will be printed.

1 page covers xx sheets Specifies how many printed sheets of paper 
the enlarged document page is to cover. 
You can select 4, 9, or 16 pages.

Print Cutting Guidelines Prints border lines on the images to guide 
you when trimming the pages.

Overlapping Panels Slightly overlaps the images so that they can 
be aligned more precisely.
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Printing a watermark on your document

To print a watermark in the background of your printed 
documents or images, select the Watermark check box in the Page 
Layout dialog box.

Select the watermark you want to print from the Name list, then 
select its position, size, color, and intensity. You can change the 
position and size of the watermark by dragging it with your 
mouse in the preview window on the left.

You can also add your own text-based or image-based 
watermarks to the Name list. Follow these steps.

1. Click the Add/Del button beside the Name list. The following 
dialog box appears.
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2. To use an image file as a watermark, click the Add PICT 
button. Select the desired image file from your hard drive, 
then click Open. 

To create a text-based watermark, click the Add Text button. 
Type the text in the Text box, select a font and a text style, then 
click OK.

3. The image file name or the watermark text appears in the list 
in the Watermark dialog box. To change the name of the 
watermark, click it in the list, then type a new name. 
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4. Click OK to add your watermark to the Name list.

Note:
When a text watermark is selected in the Name list, you can edit the 
text and change the font and text style by clicking the Edit Text 
button.

Setting the print time

You can specify the time that you want the printer to start printing 
your document. Follow these steps.

1. Click the  Background Printing icon button in the Print dialog 
box. The Background Printing dialog box appears.

2. Click On to turn on background printing, if necessary.

3. Select Urgent, Normal, Print at, or Hold as the Print Time 
option.

If you select Print at, use the arrows beside the date and time 
boxes to specify the date and time you want to print the 
document.

Note:
Make sure the computer and printer are turned on at the date and 
time you specified.
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4. Click OK. The Background Printing dialog box closes.

5. In the Print dialog box, make sure your print settings are as 
you want them, then click Print.

Note:
You can check or change the priority of print jobs using the EPSON 
Monitor3 utility. See “Controlling Background Printing” for details.

Previewing your printout

Clicking the  Preview icon button in the Print dialog box allows 
you to see how your document will look before actually printing 
it. Follow these steps to use this feature.

1. Make your printer driver settings.

2. Click the  Preview icon button in the Print dialog box. The 
Print button changes into a Preview button. 

Note:
Use the  Preview icon button to switch between the  Print, Preview, 
and Save File modes. Click the icon to select the mode you want. 
For information on the Save File mode, see “Saving print data in 
files”.
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3. Click the Preview button. The Preview dialog box appears 
and displays a preview of your document.

The Preview dialog box contains six icon buttons you can use to 
perform the following functions.

Selection Lets you select, move, and resize 
watermarks.

Zoom Enlarges or reduces the viewing size of the 
previewed page.

Margin 
Display/
Non-
Display

Shows or hides borderlines indicating the 
printable area.

Watermark 
Editing

Shows or hides the Watermark Edit box. 
Use this box to apply watermarks to the 
document.

Add Page

Remove 
Page

Lets you select or deselect the pages you 
want to print from the left-side column.
-70      



4. If you are satisfied with the previewed image, click Print.

If you are not satisfied with the appearance of the image, click 
Cancel. The Preview and Print dialog boxes close with the 
current print settings preserved. Open the Print dialog box 
again to make more changes to the print settings.

Saving print data in files

You can save print data in a file by using the  Save File icon button 
in the Print dialog box. This feature lets you print the data at a 
later time simply by double-clicking the saved file. Follow these 
steps.

Note:
Use the  Preview icon button to switch between the  Print, Preview, 
and  Save File modes. Click the icon to select the mode you want.

1. Make your printer driver settings.

2. Click the  Preview icon button in the Print dialog box 
repeatedly until the Print button changes into the Save File 
button.

3. Click the Save File button. The following dialog box appears. 

4. Select the location where you want to save the file, then type 
a file name into the Save As box and click Save.
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When you want to print the data, double-click the file to open 
EPSON Monitor 3. Click the Resume button to send the data to 
the printer.

Using the Printer Utilities for Macintosh

EPSON printer utilities allow you to check the current printer 
status and do some printer maintenance from your screen. To 
access the utilities, click the  Utility icon button in the Print or Page 
Setup dialog box, then click the button for the utility you want to 
use.

EPSON StatusMonitor

The StatusMonitor utility regularly monitors the printer status. If 
it detects a printer error, it will inform you with an error message.

You can also use this utility to check how much ink is remaining 
before printing.

To use the StatusMonitor, click the EPSON StatusMonitor button 
in the Utility dialog box. For details, see “Using the EPSON 
StatusMonitor”.
-72      



Note:
Do not use the Nozzle Check, Head Cleaning, or Print Head Alignment 
utilities while printing is in progress; otherwise your printout may be 
marred.

Nozzle Check

Checks the print head nozzles for clogging. Check the nozzles if 
you notice print quality has declined and also after cleaning to 
confirm that the print head nozzles have been cleaned. In case the 
nozzle check indicates the print head needs cleaning, you can 
access the Head Cleaning utility directly from the Nozzle Check 
utility. For details, see “Checking the Print Head Nozzles”.

Head Cleaning

Cleans the print head. You may need to clean the head when you 
notice print quality has declined. Use the Nozzle Check utility 
first to confirm that the head needs to be cleaned. For details, see 
“Cleaning the Print Head”.

Print Head Alignment

This utility aligns the print head. Use this utility if you notice a 
misalignment of vertical or horizontal lines.

Configuration

Clicking this button displays the Configuration dialog box, where 
you can change the way the StatusMonitor utility notifies you 
when the printer status changes. For details, see “Making 
Configuration Settings”.
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Replacing Ink Cartridges

Replacing an Empty Ink Cartridge

Using the printer's control panel

The printer’s indicator lights will inform you when it is time to 
obtain a replacement ink cartridge and when it is time to replace 
an empty cartridge.

Note:
If you need to replace an ink cartridge when the B black and A color 
lights are off, see “Replacing an Old or Damaged Ink Cartridge”.

This table describes the status of the lights on your printer and 
the actions you need to take.

Lights Action

Obtain a replacement black ink cartridge (S020187).

Replace the empty black ink cartridge.

Obtain a replacement color ink cartridge (S020191).

Replace the empty color ink cartridge.
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w Warning:
Keep ink cartridges out of the reach of children. Do not allow 
children to drink from or otherwise handle the cartridges.

c Caution:
❏ EPSON recommends the use of genuine EPSON ink 

cartridges. Other products not manufactured by EPSON 
may cause damage to your printer not covered by EPSON's 
warranties.

❏ Leave the old cartridge installed in the printer until you have 
obtained a replacement. Otherwise, ink remaining in the 
print head nozzles may dry out.

Note:
You cannot continue printing with one ink cartridge empty, even if the 
other cartridge still contains ink. Before printing, replace the empty 
cartridge.

- - - HTML Page Break - - -

To replace an ink cartridge using the printer’s control panel, 
follow the steps below. 

1. Make sure the printer is on. The P power light should be on, 
but not flashing. (Determine which cartridge needs to be 
replaced as indicated by the B black and A color ink out light.)

2. Lower the output tray at the front of the printer, then open 
the printer cover.
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3. Hold down the R cleaning button for three seconds. The 
print head moves left to the ink cartridge replacement 
position, and the P power light begins flashing.

c Caution:
Do not move the print head by hand as this may damage the 
printer. Always use the R cleaning button to move it. 

Note:
If you press the R cleaning button for three seconds when the 
B black and A color ink out lights are off, the printer starts cleaning 
the print head.

4. Lift up the clamp that holds the cartridge you want to replace 
as far as it will go. The cartridge rises partly out of the 
cartridge holder. Then lift the cartridge out of the printer and 
dispose of it properly. Do not take the used cartridge apart or 
try to refill it.
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w Warning:
If ink gets on your hands, wash them thoroughly with soap 
and water. If ink gets into your eyes, flush them immediately 
with water.

c Caution:
Once you open the ink cartridge clamp, the ink cartridge 
becomes unusable and cannot be reinstalled, even if ink 
remains.

5. Remove the new ink cartridge from its protective bag. Next, 
remove only the yellow tape seal from the cartridge.

c Caution:
❏ You must remove the yellow tape seal from the cartridge 

before installing it. The cartridge will be permanently 
damaged if installed with the yellow tape attached.

❏ Do not remove the blue portion of the tape seal from the 
top of the cartridge; otherwise, the print head may 
become clogged and will be unable to print.

❏ Do not remove the tape seal from the bottom of the 
cartridge; otherwise, ink will leak.
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6. Place the ink cartridge gently into the cartridge holder with 
the label on the cartridge facing up. Then press the ink 
cartridge clamp down until it locks in place. Do not press 
down on the cartridge itself.

c Caution:
Once you install the ink cartridges, do not open their clamps 
again until you replace the cartridges. Otherwise, the 
cartridges may become unusable.

7. Press the R cleaning button. The printer moves the print 
head and begins charging the ink delivery system. This 
process takes about one minute to complete. When the ink 
charging process is finished, the printer returns the print head 
to its home position and the P power light stops flashing.
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c Caution: 
The P power light continues to flash while the printer 
performs the ink charging operation. Never turn off the 
printer while this light is flashing. Doing so can result in 
incomplete charging of ink.

8. Close the printer cover.

- - - HTML Page Break - - -

Using the Status Monitor 3

You can monitor the remaining ink levels from your computer 
and view on-screen instructions for replacing a low or empty ink 
cartridge.

When an ink cartridge is low or empty, click the How To button 
in the Status Monitor’s Printer Status window; the print head 
moves to the ink cartridge replacement position. Follow the on-
screen instructions to replace the cartridge.

For more information on installing and using the Status Monitor, 
see “Using EPSON Status Monitor 3”.

Replacing an Old or Damaged Ink Cartridge 

In some circumstances you may need to replace an ink cartridge 
before it is empty. For example, if the quality of your printouts 
remains poor even after repeatedly cleaning and aligning the 
print head, one or both of the ink cartridges may be old or 
damaged and should be replaced.

To replace an ink cartridge before the B black or A color ink out 
light flashes, follow these steps.
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If the B black or A color ink out light is flashing or is on, replace 
the empty ink cartridge as described in “Replacing an Empty Ink 
Cartridge”.

c Caution:
❏ Once you remove an ink cartridge, it becomes unusable and 

cannot be reinstalled even if ink remains.

❏ Leave the old cartridge installed in the printer until you are 
ready to replace it with a new one.

1. Make sure the printer is on. The P power light should be on, 
but not flashing.

2. Lower the output tray; then open the printer cover.

3. Hold down the E load/eject button for three seconds; the 
print head moves to the replacement position. The P power 
light begins flashing.

4. Lift the appropriate ink cartridge clamp. Then lift the ink 
cartridge out of the printer and dispose of it properly.

5. Remove the yellow tape seal from the new cartridge.

6. Place the cartridge gently into the cartridge holder. Do not 
press down on the cartridge. Then press the ink cartridge 
clamp down until it locks in place.
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c Caution:
Once you install the cartridges, do not open their clamps 
again until you replace the ink cartridges. Otherwise, the 
cartridges may become unusable.

7. Press the E load/eject button again. The printer moves the 
print head back to its home position and charges ink in the 
system.

c Caution:
The P power light continues to flash while the printer 
performs the ink charging operation. Never turn off the 
printer while the P power light is flashing. Doing so can 
result in incomplete charging of ink.

Checking the Ink Supply

For Windows users

Follow the steps below to check the amount of ink left in the 
cartridges.

Status Monitor 3

Access EPSON Status Monitor 3 in one of the following ways.
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❏ Double-click the printer-shaped shortcut icon on the taskbar 
at the bottom of your computer screen. To add a shortcut icon 
to the taskbar, see “Monitoring Preferences”.

❏ Open the printer software window, click the Utility tab, then 
click the EPSON Status Monitor 3 button.

A graphic displaying the amount of ink remaining appears.

Note:
For the color ink cartridge, the color with the least amount of ink 
determines the level that is displayed for all the colors in the cartridge.
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Progress Meter

You can check the amount of ink remaining from the EPSON 
Progress Meter dialog box while printing.

For Macintosh users

Follow the steps below to check the amount of ink left in the 
cartridges.

EPSON StatusMonitor

1. Click Print or Page Setup on the File menu of your 
application.

2. Click the Utility icon button in the dialog box.
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3. Click the EPSON StatusMonitor button in the Utility dialog 
box. A graphic appears displaying the amount of ink 
remaining.

To update the ink-level information, click the Update button.

Note:
For the color ink cartridge, the color with the least amount of ink 
determines the level that is displayed for all the colors in the cartridge.
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Maintenance

Checking the Print Head Nozzles

If you find that the printed image is unexpectedly faint or dots in 
the printed image are missing, you may be able to identify the 
problem by checking the print head nozzles.

You can check the print head nozzles from your computer with 
the Nozzle Check utility in the printer software, or from the 
printer itself by using the printer’s control panel buttons.

Using the Nozzle Check utility

Note:
Do not use the Nozzle Check utility while printing is in progress; 
otherwise your printout may be marred.

For Windows users

1. Make sure A4 or Letter size paper is loaded in the sheet feeder.

2. Access the printer software window. If you need instructions, 
see “Accessing the printer software”.

3. Click the Utility tab, then click the Nozzle Check button.

4. Follow the instructions on your screen.

For Macintosh users

1. Make sure A4 or Letter size paper is loaded in the sheet feeder.

2. Access the Print or Page Setup dialog box.

3. Click the Utility icon button, then click the Nozzle Check 
button.
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4. Follow the messages on your screen.

Using the control panel buttons

1. Make sure that A4 or Letter size paper is loaded in the sheet 
feeder.

2. Hold down the E load/eject button and press the P power 
button to turn on the printer. Then release both buttons.
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The printer prints an operation check page including your 
printer’s ROM version information, the ink counter code, and 
a nozzle check pattern. Here are sample printouts.

Good sample

Print head needs to be cleaned

If the nozzle check page does not print satisfactorily (for 
example, if any segment of the printed lines is missing) there 
is a problem with the printer. This could be a clogged ink 
nozzle or a misaligned print head. See “Cleaning the Print 
Head” for details on cleaning the print head. For information 
on aligning the print head, see “Aligning the Print Head”.

Cleaning the Print Head

If you find that the printed image is unexpectedly faint or dots in 
the printed image are missing, you may be able to solve these 
problems by cleaning the print head, which ensures that the 
nozzles are delivering ink properly.

You can clean the print head from your computer with the Head 
Cleaning utility in the printer software, or from the printer itself 
by using the printer’s control panel buttons.

segments are missing
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Note:
❏ Print head cleaning uses both color and black ink. To avoid wasting 

ink, clean the print head only if print quality declines; for example, 
if the printout is blurry or the color is incorrect or missing.

❏ Use the Nozzle Check utility to confirm that the print head needs to 
be cleaned. This saves ink.

❏ When the B black or A color ink out light is flashing or on, you 
cannot clean the print head. Replace the appropriate ink cartridge 
first.

❏ Do not start the Head Cleaning or Nozzle Check utility while 
printing is in progress; otherwise your printout may be marred.

Using the Head Cleaning utility

For Windows users

1. Make sure that both B black and A color ink out lights are off.

Note:
If the B black or A color ink out light is flashing, you can not clean 
the print head. Replace the appropriate ink cartridge first.

2. Access the printer software window. If you need instructions, 
see “Accessing the printer software”.

3. Click the Utility tab, then click the Head Cleaning button.

4. Follow the messages on your screen.

The P power light flashes while the printer performs the 
cleaning cycle. It takes about one minute to complete.

c Caution:
Never turn off the printer while the P power light is flashing. 
Doing so may damage the printer.
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5. When the P power light stops flashing, click Print nozzle 
check pattern in the Head Cleaning dialog box to confirm 
that the head is clean and to reset the cleaning cycle.

Nozzle check patterns:

Good sample

Print head needs to be cleaned

In the check pattern, if you find that any segments are missing 
from the test lines, you may need to repeat the head cleaning and 
print the nozzle check pattern again.

If print quality hasn’t improved after repeating this procedure 
four or five times, turn the printer off and leave it alone overnight. 
Then do the head cleaning again.

If the print quality still has not improved, one or both of your ink 
cartridges may be old or damaged and may need to be replaced. 
To replace an ink cartridge before it is empty, see “Replacing an 
Old or Damaged Ink Cartridge”.

If print quality remains a problem after replacing the ink 
cartridges, contact your dealer.

segments are missing
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Note:
To maintain print quality, we recommend turning on the printer for at 
least one minute every month.

For Macintosh users

1. Make sure that the printer is on, and the B black and A color 
ink out lights are off.

2. Click the Utility icon button in the Print or Page Setup dialog 
box, then click the Head Cleaning button.

3. Follow the on-screen messages.

The P power light flashes while the printer performs the 
cleaning cycle. This operation takes about one minute to 
complete.

c Caution:
Never turn off the printer while P power light is flashing. 
Doing so may damage the printer.

4. When the P power light stops flashing, click the 
Confirmation button in the Head Cleaning dialog box to 
print a nozzle check pattern and to reset the cleaning cycle. 
Use the check pattern to confirm the head is clean.

If print quality hasn’t improved after repeating this procedure 
four or five times, turn the printer off and leave it alone overnight. 
Then do the head cleaning again.

If the print quality still has not improved, one or both of your ink 
cartridges may be old or damaged and may need to be replaced. 
To replace an ink cartridge before it is empty, see “Replacing an 
Old or Damaged Ink Cartridge”.

If print quality remains a problem after replacing the ink 
cartridges, contact your dealer.
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Note:
To maintain print quality, we recommend turning on the printer for at 
least one minute every month.

Using the control panel buttons

1. Make sure that the P power light is on and that both the 
B black and A color ink out lights are off.

Note:
If the B black or A color ink out light is flashing or on, you cannot 
clean the head, and this operation will start the ink cartridge 
replacement procedure. If you do not want to replace an ink cartridge 
at this moment, press the R cleaning button to return the print 
head to its home position.

2. Hold down the R cleaning button for three seconds.

The printer starts cleaning the print head and the P power 
light begins flashing. Print head cleaning takes about one 
minute to complete.

c Caution:
Never turn off the printer while the P power light is flashing. 
Doing so may damage the printer.
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3. When the P power light stops flashing, print a few lines from 
a document to confirm that the head is clean and to reset the 
cleaning cycle.

If print quality hasn’t improved after repeating this procedure 
four or five times, turn the printer off and leave it alone overnight. 
Then do the head cleaning again.

If the print quality still has not improved, one or both of your ink 
cartridges may be old or damaged and may need to be replaced. 
To replace an ink cartridge before it is empty, see “Replacing an 
Old or Damaged Ink Cartridge”.

If print quality remains a problem after replacing the ink 
cartridges, contact your dealer.

Note:
To maintain print quality, we recommend turning on the printer for at 
least one minute every month.

Aligning the Print Head

If you notice a misalignment of vertical lines, you may be able to 
solve this problem from your computer using the Print Head 
Alignment utility in your printer software.

Note:
Do not start the Print Head Alignment utility while printing is in 
progress; otherwise, your printout may be marred.

For Windows users

1. Make sure A4 or Letter size plain paper is loaded in the sheet 
feeder.

2. Access the printer software window. If you need instructions, 
see “Accessing the printer software”.
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3. Click the Utility tab, then click the Print Head Alignment 
button.

4. Follow the messages on your screen to align the print head.

For Macintosh users

1. Make sure A4 or Letter size plain paper is loaded in the sheet 
feeder.

2. Click the Utility icon button in the Printor Page Setup dialog 
box, then click the Print Head Alignment button.

3. Follow the messages on your screen to align the print head.

Cleaning the Printer

To keep your printer operating at its best, clean it thoroughly 
several times a year.

1. Make sure the printer is turned off and all the printer’s lights 
are off. Then unplug the power cord.

2. Remove any paper from the sheet feeder.

3. Use a soft brush to carefully clean away all dust and dirt.

4. If the outer case or the inside of the sheet feeder is dirty, clean 
it with a soft, clean cloth dampened with mild detergent. Keep 
the printer cover closed to prevent water getting inside.

5. If the inside of the printer accidentally gets soiled with ink, 
wipe it off with a damp cloth.

w Warning:
Be careful not to touch the gears inside the printer.
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c Caution:
❏ Never use alcohols or thinners to clean the printer; these 

chemicals can damage the components as well as the case.

❏ Be careful not to get water on the printer mechanism or 
electronic components.

❏ Do not use a hard or abrasive brush.

❏ Do not spray the inside of the printer with lubricants; 
unsuitable oils can damage the mechanism. Contact your 
dealer or a qualified service person if lubrication is needed.

Transporting the Printer

If you need to transport your printer, carefully repack it using the 
original box and packing materials as follows:

1. Open the printer cover and make sure that the print head is 
in the home (far right) position. If not, turn on the printer and 
wait until the print head returns to the home position. Turn 
off the printer and then close the printer cover.

c Caution:
Leave the ink cartridges installed when you transport the 
printer. Removing the cartridges during transport can 
damage the printer.

2. Unplug the power cord from the electrical outlet, then 
disconnect the interface cable from the printer.

3. Remove the paper from the sheet feeder and remove the paper 
support.

4. Push in the output extension tray, and then raise the output 
tray.
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5. Open the printer cover again. Secure the ink cartridge holder 
to the printer with tape as shown below, then close the printer 
cover.

6. Attach the protective materials to both sides of the printer.

7. Repack the printer and power cord in the original box.

8. Keep the printer level during transport.

Updating Software

Updating to Windows 98

If you upgraded from Windows 95 to Windows 98, uninstall the 
printer software using the Add/Remove Programs icon in the 
Windows Control Panel, then install the printer software again.

Updating the Windows NT 4.0 driver

When you update the printer driver for Windows NT 4.0, please 
be sure to uninstall the previous printer driver before you install 
the new driver. Installing over the existing printer driver results 
in a failure to update.
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Problem Solver

Diagnosing the Problem

Troubleshooting printer problems is best handled in two easy 
steps: first diagnose the problem, then apply likely solutions until 
the problem is fixed. The information that you need to diagnose 
the most common problems is provided by the printer’s control 
panel lights and by the Status Monitor utility (for Windows 95, 
98, NT 4.0 and Macintosh).

Error indicators

You can identify many common printer problems with the lights 
on your printer’s control panel. If your printer stops working and 
the lights are on or flashing, use the following table of panel light 
patterns to diagnose the problem, then follow the recommended 
corrective measures.

Lights Problem and Solution

Paper Out

No paper is loaded in 
the printer.

Load paper in the sheet 
feeder; then press the E load/
eject button to turn this light 
off. The printer resumes 
printing.

Paper Jam

Paper has jammed in 
the printer.

Press the E load/eject button. 
The printer ejects the jammed 
paper and then resumes 
printing. If the error is not 
cleared, open the printer 
cover and remove the 
jammed paper. Then reload 
paper in the sheet feeder and 
press the E load/eject button. 
The printer resumes printing.
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Ink Low (black ink cartridge)

The black ink cartridge 
is nearly empty.

Obtain a replacement black 
ink cartridge (S020187).

Ink Out (black ink cartridge)

The black ink cartridge 
is empty.

Replace the black ink 
cartridge with a new one 
(S020187). See “Replacing an 
Empty Ink Cartridge” for 
details.

Ink Low (color ink cartridge)

The color ink cartridge 
is nearly empty.

Obtain a replacement color 
ink cartridge (S020191).

Ink Out (color ink cartridge)

The color ink cartridge 
is empty.

Replace the color ink 
cartridge with a new one 
(S020191). See “Replacing an 
Empty Ink Cartridge” for 
details.

Carriage Error

The print head 
carriage is obstructed 
by jammed paper or 
other foreign material 
and cannot return to 
the home position.

Turn off the printer. Open the 
printer cover and remove any 
paper from the paper path by 
hand. Then turn the printer 
back on.

If the error is not cleared, 
contact your dealer.
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Status Monitor 3

The Status Monitor 3 utility’s Printer Status window provides 
status messages and a graphic display showing the current state 
of the printer.

If a problem occurs while printing, an error message appears in 
the Progress Meter window.

When ink is out, click the How To button in the Printer Status 
window and the Status Monitor will lead you step-by-step 
through the cartridge replacement procedure.

- - - HTML Page Break - - -

Running a printer operation check

Performing a printer operation check can help you determine 
whether the problem comes from the printer or the computer.

To print a printer operation check page, follow these steps.

1. Make sure both the printer and computer are turned off.

2. Disconnect the cable from the printer’s interface connector.

Unknown Printer Error

An unknown printer 
error has occurred.

Turn off the printer, and 
contact your dealer.
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If you use the parallel interface, unlock the wire clips on both 
sides of the interface connector and remove the ground 
connector, if necessary. Then disconnect the cable from the 
printer’s interface connector.

3. Make sure that A4 or Letter size paper is loaded in the sheet 
feeder.

4. Hold down the E load/eject button and press the P power 
button to turn on the printer. Then release both buttons.

The printer prints an operation check page including the 
version of your printer’s ROM, the ink counter code, and a 
nozzle check pattern. 
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❏ Compare the quality of the printed check page with the 
sample shown below. If there are no print quality problems, 
such as gaps or missing segments in the test lines, the printer 
itself is all right and the problem probably lies in the printer 
software settings, application settings, the interface cable (be 
sure to use a shielded cable), or the computer itself.

❏ If the check page does not print satisfactorily as shown below, 
there is a problem with the printer. For example, if any 
segment of the printed lines is missing, this could be a clogged 
ink nozzle or a misaligned print head.

Cancelling Printing

If the printouts are not what you expected and display incorrect 
or garbled characters or images, you may need to cancel printing. 
To cancel printing, follow the steps below.

segments are missing
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For Windows

When you send a print job to the printer, the Progress Meter 
appears on your computer screen.

Click the Stop button to cancel printing.

For Macintosh

When background printing is on

1. Press the P power button to turn off the printer.

2. Select EPSON Monitor3 from the application menu.
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3. Click on the document which is printing, then click the  Stop 
icon button to cancel the print job.

When background printing is off

1. Press the P power button to turn off the printer.

2. Hold down the command key on your keyboard and press 
the period (.) key to cancel the print job.

Print Quality Could Be Better

If you are having print quality problems, first perform a 
“<As_test.htm>Test Printing”. Then, compare your test printing 
with the illustrations below. Click the caption under the 
illustration that best resembles your printout.

“Horizontal banding” “Vertical misalignment or 
banding”
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Horizontal banding

Try one or more of these solutions.

❏ Make sure the printable side of the paper is face up in the sheet 
feeder.

❏ Run the Head Cleaning utility to clear any clogged ink 
nozzles. Windows 95 or 98 users can start the 
“<As_head.htm>Head Cleaning Utility” now.

❏ Select the Automatic mode in your printer driver’s Main 
menu (Windows) or Print dialog box (Macintosh).

❏ Check the B black and A color ink out lights. If a light is 
flashing, replace the ink cartridge. See “Replacing an Empty 
Ink Cartridge”.

“Horizontal banding” “Vertical misalignment or 
banding”

“Color gaps” “Incorrect or missing colors”

“Blurry or smeared printout”
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❏ Make sure the Maximum Printable Area setting in your 
printer driver is deselected. When this setting selected, 
banding may occur in the expanded area.

Vertical misalignment or banding

Try one or more of these solutions.

❏ Make sure the printable side of the paper is face up in the sheet 
feeder.

❏ Run the Print Head Alignment utility. Windows 95 or 98 users 
can start the “<As_alig.htm>Print Head Alignment Utility” 
now.

❏ Turn off the High Speed setting in your printer driver. For 
instructions, see “Using the Advanced settings” for 
Windows. For Macintosh, see “Using the Advanced settings”.

❏ Run the Head Cleaning utility to clear any clogged ink 
nozzles. Windows 95 or 98 users can start the 
“<As_head.htm>Head Cleaning Utility” now.

Color gaps

Try one or more of these solutions.

❏ Make sure your paper is not damaged, dirty, or too old. Also, 
make sure the printable side of the paper is face up in the sheet 
feeder.

❏ Run the Head Cleaning utility to clear any clogged ink 
nozzles. Windows 95 or 98 users can start the 
“<As_head.htm>Head Cleaning Utility” now.

❏ Check the B black and A color ink out lights. If one of the lights 
is flashing, replace the appropriate ink cartridge. See 
“Replacing an Empty Ink Cartridge”.
-104      



❏ Adjust the color settings in your application software or your 
printer driver. For instructions, see “Using the Advanced 
settings” for Windows or “Using the Advanced settings” for 
Macintosh.

❏ Select the Automatic mode in your printer driver’s Main 
menu (Windows) or Print dialog box (Macintosh).

Incorrect or missing colors

Try one or more of these solutions.

❏ Change the ink setting in your printer driver to Color. For 
instructions, see “Using the Automatic mode” for Windows 
or “Using the Automatic settings” for Macintosh.

❏ Adjust the color settings in your application software or your 
printer driver. For instructions, see “Using the Advanced 
settings” for Windows or “Using the Advanced settings” for 
Macintosh.

❏ Run the Head Cleaning utility. Windows 95 or 98 users can 
start the “<As_head.htm>Head Cleaning Utility” now. If 
colors are still incorrect or missing, replace the color ink 
cartridge. If the problem persists, replace the black ink 
cartridge. See “Replacing an Old or Damaged Ink Cartridge”.

Blurry or smeared printout

Try one or more of these solutions.

❏ Make sure your paper is dry and the printable side is facing 
up. Also, make sure you’re using a correct paper type. See 
“Paper” for specifications.

❏ Select the Automatic mode in your printer driver’s Main 
menu (Windows) or Print dialog box (Macintosh).

❏ Set the adjust lever to the “+” position, and make sure the 
Media Type setting is set correctly in your printer driver.
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❏ If the paper is curled toward the printable side, flatten it or 
curl it slightly toward the opposite side. 

❏ Remove each sheet from the output tray as it’s printed, 
especially if you’re using transparencies.

❏ If you’re printing on glossy media or transparencies, place a 
support sheet (or a sheet of plain paper) beneath the stack. Or 
load one sheet at a time.

❏ Run the Head Cleaning utility. Windows 95 or 98 users can 
start the “<As_head.htm>Head Cleaning Utility” now.

❏ Run the Print Head Alignment utility. Windows 95 or 98 users 
can start the “<As_alig.htm>Print Head Alignment Utility” 
now.

❏ Ink may have leaked inside the printer; wipe the inside of the 
printer with a soft, clean cloth.

Printouts Are Not What You Expected

If one of the following problems has occurred, try the solutions 
listed for the problem.
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Incorrect or garbled characters

Try one or more of these solutions.

❏ Select your printer as the default printer in Windows.

❏ Clear any stalled print jobs from the Spool Manager. For 
instructions, see “Using EPSON Spool Manager”.

❏ Turn off the printer and computer. Make sure the printer’s 
interface cable is securely plugged in.

❏ If you are using Windows NT 4.0, try to uninstall the EPSON 
Printer Port. Click Start, point to Programs, then point to 
EPSON Printers and click EPSON Printer Port Uninstall. 
Follow the instructions on the screen.

Incorrect margins

Try one or more of these solutions.

❏ Check the margin settings in your application software.

❏ Make sure the margins are within the printable area of the 
page. See “Paper” for specifications.

❏ For Windows, check the settings in the Paper menu. Make 
sure the settings are correct for the paper size you’re using.

For Macintosh, check the settings in the Page Setup dialog 
box. Make sure the settings are correct for the paper size 
you’re using.

Inverted image

Turn off the Flip Horizontal setting in the printer driver, or the 
“Mirror” setting in your application software. For instructions, 
see online help for the printer driver or for your application.
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For Macintosh, see also “Using the Advanced settings”.

Blank pages print

Try one or more of these solutions.

❏ Select your printer as the default printer in Windows.

❏ For Windows, check the settings in the Paper dialog box. 
Make sure they’re correct for the paper size you’re using.

For Macintosh, check the settings in the Page Setup dialog 
box. Make sure they’re correct for the paper size you’re using.

❏ Run the Head Cleaning utility to clear any clogged nozzles. 
Windows 95 or 98 users can start the “<As_head.htm>Head 
Cleaning Utility” now.

After trying one or more of these solutions, run a printer operation 
check to check your results. See “Running a printer operation 
check”.

Printout has smears on the bottom edge 

Try one or more of these solutions.

❏ If the paper is curled toward the printable side, flatten it or 
curl it slightly toward the opposite side. 

❏ Set the adjust lever to the “+” position, and turn off the High 
Speed setting in your printer driver’s Advanced dialog box. 
The Advanced dialog box is accessible through the Main 
menu (for windows) or Print dialog box (for Macintosh) when 
Custom mode is selected. To turn this option off, you may 
also need to change the Print Quality setting.
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Printing is too slow

Try one or more of these solutions.

❏ Make sure the Media Type setting is set correctly in your 
printer driver. For instructions, see “Making the Media Type 
setting” for Windows or “Making the Media Type setting” for 
Macintosh.

❏ Select the Automatic mode in your printer driver’s Main 
menu (Windows) or Print dialog box (Macintosh) and then 
set the slide bar to the Speed setting. For instructions, see 
“Using the Automatic mode” for Windows or “Using the 
Automatic settings” for Macintosh.

❏ Don’t run too many applications at the same time. Close any 
applications you are not using at the moment.

❏ Delete unnecessary files to make room on your hard disk 
drive.

Note:
Your computer may not have enough memory. For further tips, See 
“Increasing the Print Speed”.

❏ If you upgraded from Windows 95 to Windows 98, uninstall 
the printer software using Add/Remove Programs from the 
Control Panel in Windows, then install the software again.

Printer Doesn't Print

If one of the following problems has occurred, try the solutions 
listed.

All lights are off

❏ Press the P power button and make sure the printer is on.
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❏ Turn off the printer and make sure the power cord is securely 
plugged in.

❏ Make sure your outlet works and is not controlled by a wall 
switch or timer.

Lights came on and then went out

The printer’s voltage may not match the outlet rating. Turn off the 
printer and unplug it immediately. Then, check the printer labels.

If the voltage doesn’t match, DO NOT PLUG YOUR PRINTER 
BACK IN. Contact your dealer.

Only the power light is on

❏ Turn off the printer and computer. Make sure the printer’s 
interface cable is securely plugged in.

❏ Make sure there is no packing material in the printer.

❏ Turn off the printer and computer and disconnect the 
printer’s interface cable. Then print an operation check page. 
See “Running a printer operation check”.

❏ If the check page prints, make sure the printer software and 
your application software are installed correctly.

Note:
If you’re trying to print a large image, your computer may not have 
enough memory to print.

❏ If you are using Windows NT 4.0, try to uninstall the EPSON 
Printer Port. Click Start, point to Programs and EPSON 
Printers, then click EPSON Printer Port Uninstall. Follow the 
messages on the screen.
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❏ Clear any stalled print jobs from the Spool Manager. For 
instructions, see “Using EPSON Spool Manager”.

❏ If the printer sounds like it’s trying to print, but can’t, run the 
Head Cleaning utility. Windows 95 or 98 users can start the 
“<As_head.htm>Head Cleaning Utility” now.

❏ If the above does not work, replace the ink cartridges. See 
“Replacing an Old or Damaged Ink Cartridge” for 
instructions.

Paper out light is flashing or on

❏ If the paper out light is flashing, remove any paper that may 
be jammed in the printer.

❏ If the paper out light is on, load more paper in the sheet feeder.

One of the ink out lights is flashing or on

❏ If the B black or A color ink out light is flashing, ink is low. 
Prepare a replacement cartridge.

❏ If the B black or A color light is on, ink is out. Replace the 
corresponding cartridge. See “Replacing an Empty Ink 
Cartridge”.

Ink out lights are on and the other lights are flashing

Follow these steps.

1. Remove any paper in the printer.

2. Turn the printer off. Check for and remove any foreign objects 
or pieces of paper from inside the printer. Also, make sure 
that there is sufficient space around the vent on the back of 
the printer to allow proper ventilation. Remove any objects 
blocking the vent. Then, turn the printer back on.
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3. If the error is not cleared, contact your dealer.

Paper Doesn't Feed Correctly

If one of the following problems has occurred, try the solutions 
listed for the problem.

Paper doesn't feed 

Remove the stack of paper and check that:

❏ The paper isn’t curled or creased.

❏ The paper isn’t too old. See the instructions that came with 
the paper for more information.

❏ Paper isn’t loaded above the arrow on the left edge guide.

❏ The paper isn’t jammed inside. If it is, remove the jammed 
paper.

Then, load the paper again. Make sure you follow any special 
loading instructions that came with your paper. See also the paper 
handling section in this guide.

Multiple pages feed

Remove the stack of paper and:

❏ Make sure the paper is not too thin. See “Paper” for 
specifications.

❏ Fan the edges of the stack to separate the sheets, then reload 
the paper.
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If too many copies of a document are printing, check the Copies 
settings in both the printer driver and your application. For 
instructions, see “Modifying the printout style” for Windows or 
“Modifying the layout” for Macintosh.

The paper jams

Press the E load/eject button to eject the jammed paper. If the 
error message does not clear, open the cover and remove all the 
paper inside, including any torn pieces. Then load the paper 
again.

If your paper jams frequently, make sure you:

❏ Use smooth, high-quality paper, loaded with the printable 
side up.

❏ Fan the stack before loading it.

❏ Don’t load paper above the arrow mark on the left edge guide.

❏ Adjust the left edge guide to fit your paper.

Paper isn't ejected fully or is wrinkled

Try one or more of these solutions.

❏ If the paper doesn’t eject fully, press the E load/eject button. 
Also check the paper size setting in your application or printer 
driver.

❏ If the paper is wrinkled when it comes out, it may be damp 
or too thin. Load a new stack.

Note:
Store any unused paper in its original packaging in a dry area. See 
“Paper” for specifications.
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Where to Get Help

If your printer is not operating properly and you cannot solve the 
problem using the troubleshooting information in your printer 
documentation, contact customer support services for assistance.

Customer support will be able to help you much more quickly if 
you give them the following information.

❏ Serial number of your printer
(The serial number label is on the back of the printer.)

❏ Printer model

❏ Brand and model of your computer

❏ Printer software version
(Click About in your printer driver.)

❏ Windows version you are using

❏ Software application(s) you normally use with your printer 
and their version number(s)

Select your country:

❏ “For United Kingdom and the Republic of Ireland Users”

❏ “For Australian Users”

❏ “For Singapore Users”

❏ “For Hong Kong Users”

❏ “For Philippines Users”

For United Kingdom and the Republic of Ireland Users

If you purchased your printer in the UK or the Republic of Ireland, 
EPSON (UK) Limited provides a range of customer services and 
technical support. 
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World Wide Web

If you can connect to the Internet and have a Web browser, you 
can access our Web site at http://www.epson.co.uk. Here you 
will find information on the latest EPSON products, software 
drivers, on-line user guides, and answers to frequently asked 
questions. 

Faxon EPSON

Contact Faxon EPSON Faxback Service for support information 
including troubleshooting tips, switch settings, and driver 
information. 

To use Faxon EPSON, call 01442 227332 in the UK or 0044 1442 
227332 from the Republic of Ireland using a touch-tone phone. 
You will be asked to follow a simple routine to register your 
document request. Once you have entered your telephone and fax 
numbers, Faxon EPSON will fax a copy of the document catalogue 
to your fax machine. 

When you have found the documents that you need in the 
catalogue, call Faxon EPSON again and enter the document ID 
numbers. The documents will be faxed to you automatically. 

Bulletin Board Service for latest drivers and utilities

You can call the EPSON Bulletin Board Service on 01442 227479 
in the UK or 0044 1442 227479 from the Republic of Ireland. No 
membership is required. Make sure that your communications 
software is set to 8 data bits, 1 stop bit, no parity bit, ANSI terminal 
mode emulation, and a modem speed of up to 28.8 Kbps. 
Downloading protocols supported include Xmodem, Ymodem 
and Zmodem. See the documentation that came with your 
communications software and modem for more information. 

When you first connect to the Bulletin Board Service, you will be 
asked for your name, company name, phone number and a 
password (which you can invent yourself). 
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Customer and Warranty Support

Our Customer and Warranty Support teams can be contacted by 
calling 0870 163 7766 in the UK or 0044 0870 163 7766 from the 
Republic of Ireland. They can provide the following services:

❏ Technical information on installing, configuring, and 
operating your EPSON products

❏ Arranging for faulty EPSON products to be repaired within 
the warranty period

A full list of EPSON Customer and Warranty Support services is 
available on the technical support section of our World Wide Web 
pages at http://www.epson.co.uk/support/ and on Faxon 
EPSON Faxback service in document number 5085.

Pre Sales Enquiry Desk

The Enquiry Desk team can be contacted by calling 0800 220546 
in the UK or 1 800 409132 from the Republic of Ireland, by faxing 
01442 227271 in the UK or 0044 1442 227271 from the Republic of 
Ireland, and via Email at info@epson.co.uk. They can provide 
the following information:

❏ Pre Sales information and literature on new EPSON products 
(also available via our world wide web site at 
http://www.epson.co.uk)

❏ Where to purchase genuine EPSON consumables, 
accessories, and options

For Australian Users

EPSON Australia wishes to provide you with a high level of 
Customer Service. As well as the user’s guide, we provide the 
following sources for obtaining information: 
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EPSON FAXBACK

EPSON FAXBACK will fax you the latest specifications and 
pricing for most EPSON products offered in Australia. There is 
also technical information including details of the latest software 
and drivers available. Phone (02) 9903 9075 and the system will 
guide you through a number of choices before faxing the 
information to your fax machine. 

EPSON Bulletin Board System

This is where you can download the latest software and drivers. 
Visit the BBS to check out the latest versions. If you have a modem, 
phone (02) 9417 5090. 

Internet URL http://www.epson.com.au

Access the EPSON Australia World Wide Web pages. Worth 
taking your modem here for the occasional surf! You can get the 
same information as offered on the EPSON FAXBACK and the 
EPSON Bulletin Board plus more. 

Your dealer

Don’t forget that your dealer can often help identify and resolve 
problems. The dealer should always be the first call for advice on 
problems. They can often solve problems quickly and easily as 
well as give you advice on the next step to take.

EPSON Helpdesk

EPSON Helpdesk is provided as a final backup to make sure our 
clients have access to advice. Operators on the Helpdesk can aid 
you in diagnosing hardware and software problems. They can 
also advise you on the latest EPSON products and where the 
nearest dealer or service agent is located. Many types of queries 
are answered here.
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The Helpdesk numbers are:

We encourage you to have all the relevant information on hand 
when you ring. The more information you prepare, the faster we 
can help solve the problem. This information includes the User’s 
Guide for your EPSON product, type of computer, operating 
system, application programs, and any other information you feel 
is required. 

For Singapore Users

Contact the telephone and fax numbers below:

For Hong Kong Users

To obtain technical support as well as other after-sales services, 
users are welcome to contact EPSON Hong Kong Limited. 

Internet home page

EPSON Hong Kong has established a local home page in both 
Chinese and English on the Internet to provide users with the 
following information:

❏ Product information

❏ Answers to Frequently Asked Questions (FAQs)

❏ Latest versions of EPSON printer drivers

Users can access our World Wide Web home page at: 
http://www.epson.com.hk

Phone (02) 9903 9040

Fax (02) 9903 9189

Phone (065) 337-7911

Fax (065) 334-1185
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Electronic bulletin board system

An electronic bulletin board system (BBS) is also available to 
obtain printer information and the latest versions of printer 
drivers. You can log on to the following number for the BBS 
service:

Technical Support Hotline

You can also contact our technical staff at the following telephone 
and fax numbers:

For Philippines Users

To obtain technical support as well as other after sales services, 
users are welcome to contact the EPSON Philippines 
Representative Office at the telephone and fax numbers below:

BBS (852) 2827-4244

Phone (852) 2585-4399

Fax (852) 2827-4383

Phone (632) 813-6552

Fax (632) 813-6545

BBS (632) 814-0595
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Options and Consumable Products

Options

The following interface cables and interface cards are available 
for your printer.

Interface cables

EPSON supplies the following interface cable. However, you can 
use any interface cable that meets these specifications. See your 
computer manual for any additional requirements.

❏ Parallel Interface Cable (shielded) C83602✽  from D-SUB 25-
pin (computer) to 36-pin Amphenol 57 Series (printer)

Note:
❏ The asterisk (✽ ) is a substitute for the last digit of the product 

number, which varies by location.

❏ To connect the printer to your PC or Macintosh using the USB 
interface (Windows 98 pre-installed PCs and iMac or G3 model 
Macintosh computers only), you must first purchase an USB 
conversion cable.

c Caution:
Use only interface cables which meet the specifications listed 
above. Using other cables not covered by EPSON warranties may 
cause the printer to malfunction.

Consumable products

The following ink cartridges and EPSON special media are 
available for your printer.
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Ink cartridges

You can use the following cartridges with your printer.

Note:
The product numbers of ink cartridges vary by location.

EPSON special media

EPSON offers specifically designed media for ink jet printers to 
meet most high-quality printing needs.

Black ink cartridge S020187

Color ink cartridge S020191

EPSON Premium Ink Jet Plain Paper (A4) S041214

EPSON 360 dpi Ink Jet Paper (A4) S041059
S041025

EPSON 360 dpi Ink Jet Paper (Letter) S041060
S041028

EPSON Photo Quality Ink Jet Paper (A4) S041061
S041026

EPSON Photo Quality Ink Jet Paper (Letter) S041062
S041029

EPSON Photo Quality Ink Jet Paper (Legal) S041067
S041048

EPSON Photo Quality Ink Jet Card (A6) S041054

EPSON Photo Quality Ink Jet Card (5 × 8”) S041121

EPSON Photo Quality Ink Jet Card (8 × 10”) S041122

EPSON Photo Quality Self Adhesive Sheet (A4) S041106

EPSON Ink Jet Note Cards A6
(with envelopes)

S041147

EPSON Ink Jet Greeting Cards 5 × 8”
(with envelopes)

S041148

EPSON Ink Jet Greeting Cards 8 × 10”
(with envelopes)

S041149

EPSON Photo Quality Glossy Film (A4) S041071
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Note:
The availability of special media varies by location.

EPSON Photo Quality Glossy Film (Letter) S041072

EPSON Photo Quality Glossy Film (A6) S041107

EPSON Ink Jet Transparencies (A4) S041063

EPSON Ink Jet Transparencies (Letter) S041064

EPSON Photo Paper (A4) S041140

EPSON Photo Paper (Letter) S041141

EPSON Photo Paper (4 × 6”) S041134

EPSON Photo Paper (100 × 150 mm) S041255

EPSON Photo Paper (200 × 300 mm) S041254

EPSON Photo Paper Cards (A4) S041177

EPSON Photo Stickers 16 (A6) S041144

EPSON Photo Stickers 4 (A6) S041176

EPSON Panoramic Photo Paper (210 × 594 mm) S041145

EPSON Iron-On Cool Peel Transfer Paper (A4) S041154

EPSON Iron-On Cool Peel Transfer Paper (Letter) S041153
S041155

EPSON Matte Paper-Heavyweight (A4) S041256
S041258
S041259
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